GTW-LC

GT System Lift control adaptor
**General Prohibitions**

1. Do not dismantle or alter the unit. Fire or electric shock could result.
2. The unit must be installed and wired by a qualified technician.
3. Do not connect any non-specified power source to the +, - terminals, and do not install two power supplies in parallel to a single input. Fire, damage to the unit, or system malfunction could result.
4. Keep the unit away from water or any other liquid. Fire or electric shock could result.
5. Do not connect any terminal on the unit to AC power lines. Fire or electric shock could result.
6. Do not put any metal or flammable material into the unit through the openings. Fire, electric shock, or unit trouble could result.
7. Do not install or make any wire terminations while the lift or any other systems are powered on. It can cause electrical shock, damage, or malfunction to the other systems.
8. When checking the operation of the lift or other systems, ensure the safety of others in the surrounding area before starting. Failure to do so could cause an accident.

**General Precautions**

1. Do not install or make any wire terminations while power supply is plugged in. It can cause electrical shock or damage to the unit.
2. Before turning on power, make sure wires are not crossed or shorted. Fire or electric shock could result.
3. Do not put anything on or cover the unit with cloth, etc. Fire or unit trouble could result.
4. For DC powered systems, use Aiphone power supply model specified with system. If non-specified product is used, fire or malfunction could result.
5. Do not install the unit in any of the following locations. Fire, electric shock, or unit trouble could result.
   * Places under direct sunlight, or near heating equipment that varies in temperature.
   * Places subject to dust, oil, chemicals, hydrogen sulfide (hot spring).
   * Places subject to moisture and humidity extremes, such as bathroom, cellar, greenhouse, etc.
   * Places where the temperature is quite low, such as inside a refrigerated area or in front of air-conditioner.
   * Places subject to steam or smoke (near heating or cooking surfaces).
   * Where noise generating devices such as dimmer switches, inverter electrical appliances, are closely.
6. When mounting the unit on wall, install the unit in a convenient location, but not where it could be jarred or bumped. Injury could result.
7. Do not place (install) the unit in locations subject to frequent vibration or impact. Injury or damage could result if the unit falls.

**WARNNING**

(Negligence could result in death or serious injury.)

1. Do not dismantle or alter the unit. Fire or electric shock could result.
2. The unit must be installed and wired by a qualified technician.
3. Do not connect any non-specified power source to the +, - terminals, and do not install two power supplies in parallel to a single input. Fire, damage to the unit, or system malfunction could result.
4. Keep the unit away from water or any other liquid. Fire or electric shock could result.
5. Do not connect any terminal on the unit to AC power lines. Fire or electric shock could result.
6. Do not put any metal or flammable material into the unit through the openings. Fire, electric shock, or unit trouble could result.
7. Do not install or make any wire terminations while the lift or any other systems are powered on. It can cause electrical shock, damage, or malfunction to the other systems.
8. When checking the operation of the lift or other systems, ensure the safety of others in the surrounding area before starting. Failure to do so could cause an accident.

**CAUTION**

(Negligence could result in injury to people or damage to property.)

1. Do not install or make any wire terminations while power supply is plugged in. It can cause electrical shock or damage to the unit.
2. Before turning on power, make sure wires are not crossed or shorted. Fire or electric shock could result.
3. Do not put anything on or cover the unit with cloth, etc. Fire or unit trouble could result.
4. For DC powered systems, use Aiphone power supply model specified with system. If non-specified product is used, fire or malfunction could result.
5. Do not install the unit in any of the following locations. Fire, electric shock, or unit trouble could result.
   * Places under direct sunlight, or near heating equipment that varies in temperature.
   * Places subject to dust, oil, chemicals, hydrogen sulfide (hot spring).
   * Places subject to moisture and humidity extremes, such as bathroom, cellar, greenhouse, etc.
   * Places where the temperature is quite low, such as inside a refrigerated area or in front of air-conditioner.
   * Places subject to steam or smoke (near heating or cooking surfaces).
   * Where noise generating devices such as dimmer switches, inverter electrical appliances, are closely.
6. When mounting the unit on wall, install the unit in a convenient location, but not where it could be jarred or bumped. Injury could result.
7. Do not place (install) the unit in locations subject to frequent vibration or impact. Injury or damage could result if the unit falls.

**GENERAL PRECAUTIONS**

1. This unit is for indoor use only. Do not use outdoors.
2. As to other systems used with this device, such as the lift, comply with the Manufacturer’s Specifications and Warranty conditions.
3. The unit turns inoperative during power failure.
4. Keep the intercom wires more than 30 cm (12 inches) away from AC 100-240 V lines, particularly AC lines for inverter electrical appliances. Noise and malfunction could result.
1 SYSTEM CONFIGURATION

1-1

System Configuration

a. GT expanded system (For details, see the GT Series Installation & Operation Manual.)

⚠️ Make sure to use GT-BCX, GT-DA(-L), GT-NS(-V), GT-DM(V).

[1] Expanded Bus control unit GT-BCX
[3] Lift control adaptor GTW-LC
   - Relay contacts: 20
[4] Bus control unit GT-BC
[5] Power supply PS-2420DIN etc.
[6] Lift controller (made by other manufacturer)
[7] Lift (made by other manufacturer)
[8] Entrance station (digital name scrolling type): Audio only or Audio/Video

⚠️ Do not use direct selection GT-SW.

| Lift control adaptor | Maximum 16 adaptors (up to 8 adaptors per trunk) |

* Capacity of other units conform to the expanded system.

1-2 Wiring Distance

* DP = Distribution Point

<table>
<thead>
<tr>
<th>Diameter of wires</th>
<th>0.65 mm (22 AWG)</th>
<th>0.8 mm (20 AWG)</th>
<th>1.0 mm (18 AWG)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GT-BCX ~ GTW-LC</td>
<td>-</td>
<td>300 m (980’)</td>
<td>-</td>
</tr>
<tr>
<td>GT-BCX ~ GT-BC</td>
<td>-</td>
<td>300 m (980’)</td>
<td>-</td>
</tr>
<tr>
<td>DP ~ GTW-LC</td>
<td>-</td>
<td>300 m (980’)</td>
<td>-</td>
</tr>
<tr>
<td>GT-BC ~ DP</td>
<td>-</td>
<td>5 m (16’)</td>
<td>-</td>
</tr>
<tr>
<td>GT-BC ~ power supply</td>
<td>-</td>
<td>5 m (16’)</td>
<td>5 m (16’)</td>
</tr>
<tr>
<td>Total wiring distance</td>
<td>-</td>
<td>2500 m (8200’)</td>
<td>-</td>
</tr>
</tbody>
</table>

* For other Wiring Distances, see the GT Series Installation & Operation Manual.
2 CONTENTS

Lift control adaptor GTW-LC (mounting bracket is included)

3 NAMES

[1] Bus line terminal
[2] ID setting switch
[3] Relay output terminal
[4] Lock release lever
**Mounting**

[1] Din rail
[2] Lock release lever

Mount GTW-LC to the Din rail.

* To remove GTW-LC, pull the lock release lever down.

⚠️ GTW-LC cannot be mounted directly to the wall surface.
GT Expanded System

Sub trunk

Common trunk

Entrance Station
(Unit Type)

Entrance Station
(Integrated Type)

GT-BCX

GTW-LC

R1
R2

R1
R2

GT-BCX

#8

#1

1P
1P

1P
1P

R1
R2

GTW-LC

RY1
1P

RY2
1P

Max. 8

to Lift controller

#9 to #16
(max. 8)

PS24

PS24

PS24

PS-2420DIN,
PS-2420UL

GT-BC

[2] DP

1P

1P

[3]

[4]

[5]
Wiring

a. GT expanded system (For details, see the GT Series Installation & Operation Manual.)

[1] Expanded Bus control unit GT-BCX
[3] Lift control adaptor GTW-LC

  Maximum 16 adaptors (up to 8 adaptors per trunk)

• ID: ID setting switch (factory setting is #1)
  △ Make sure to set corresponding ID number.

[4] Bus control unit GT-BC
[5] Power supply PS-2420DIN etc.

NP: Non-polarized
**Setup tool**

* Completing settings with the setup tool is required.
1. Install the setup tool in the PC (Windows 7/VISTA/XP ®) beforehand, and then enter the resident information.
* For details on the setup tool, refer to the GT Series Installation & Operation Manual.
   Save programmed data and resident information data to your PC is recommended.
2. Connect the PC terminal of GT-BCX to the PC with USB cable (A-B type) (included with GT-NS(-V), GT-MK, GT-DM(V)).
* PC requires USB output.
3. Start the setup tool (double-click gt_program.exe).
4. Select the system (GT or GH).
5. After inputting resident information and clicking OK, the "Lift Control 1" tab and "Lift Control 2" tab will appear if "Lift Control" is selected in the "View" menu.

⚠️ If resident information is not input, the "Lift Control 1" tab and "Lift Control 2" tab will not appear.
Lift Control 1
[1] GTW-LC ID
[2] Select ‘ON’ or “OFF” for the GTW-LC connection.
[4] Set the Timer. The time setting range is 1 to 600 sec. (one second increments)
  - Clicking the upper spin button will increase the time setting, and clicking the
    lower spin button will decrease the time setting. At this time, a numerical value
    exceeding either the upper or lower value limits cannot be set.
  - The number of seconds can be input directly by clicking inside of the Timer
    box.
  - Input can be set by pressing the Enter key or by clicking inside of another Timer
    box.
[5] After GT system settings are completed, the connected GTW-LC ID
    numbers will display in black if the “Check” button is clicked while
    connected to GT-BCX.
⚠ The system will be in use when Connecting status is being checked.
    Checking connections is not possible while the system is in use.

Lift Control 2
[1] The resident information that has been entered will be displayed.
[2] Set which relay will activate in the corresponding GTW-LC for each
    residence. The setting range is 1 to 20.

Data transfer
1. Select ‘Export’ in the “Connection” menu.
2. If “Yes” is selected, the data will be transferred to GT-BCX.
Combine Data
The data entered in the GT-BCX can be combined with the data entered in the GT-NS(V), GT-MK or GT-DM(V), and this data can be saved as master data.

1. Select and open the corresponding data with "Open" in the "File" menu.
2. Selecting "Lift Control" in the "View" menu makes it possible to select "Combine Data" in the "File" menu.
3. Select and open the corresponding data.
4. Click the checkboxes for the items to be combined, and select "Combine" to combine the data. Assign a file name and save.

Residential Station or Security Guard Station Door Release
1. Press the door release button at the residential station or security guard station while in communication with the entrance station that made a call.
2. The door release function will activate on the entrance station that is in communication, and the lift will begin to move.

* In the cases below, the lift will not move.
  - If the talk button is pressed and the residential station goes into talk mode while the entrance is being monitored.
  - When the entrance station access code is input and the door is released. In this case, using a proximity card etc. to activate the lift to go to their specific floor. (This function depends on the lift.)

Automatic Entry (Doctor Call) Option
1. A visitor presses the call button of the entrance station.
2. If the automatic entry is set, the release mechanism is activated and the lift will begin to move at the same time.

The lift operates according to the lift controller settings.

* For details on the automatic entry (doctor call), refer to the GT Series Installation & Operation Manual.
8 TECHNICAL PRECAUTIONS

Technical precautions
• Operating temperature: 0 °C to +40 °C (+32 °F to +104 °F)
• Repair requests: When units do not operate properly, contact a qualified technician for service.

9 SPECIFICATIONS

Specifications
• Power supply: Supplied by GT-BC
• Relay contacts: 20 AC/DC 24 V, 500mA, N.O./N.C. dry closure operation time accuracy ±2%
• Wiring: single-pair cable
• Type of cable: Pair cable (solid wire not stranded), polyethylene insulated, diameter 0.65 ~ 1.0 mm
• Dimensions: 210 (W) x 108.5 (H) x 61 (D) mm (8-1/4 x 4-1/4 x 2-3/8 inch)
• Weight: Approx. 330 g (0.7 lbs.)
Aiphone warrants its products to be free from defects of material and workmanship under normal use and service for a period of two years after delivery to the ultimate user and will repair free of charge or replace at no charge, should it become defective upon which examination shall disclose to be defective and under warranty. Aiphone reserves unto itself the sole right to make the final decision whether there is a defect in materials and/or workmanship; and whether or not the product is within the warranty. This warranty shall not apply to any Aiphone product which has been subject to misuse, neglect, accident, or to use in violation of instructions furnished, nor extended to units which have been repaired or altered outside of the factory. This warranty does not cover batteries or damage caused by batteries used in connection with the unit. This warranty covers bench repairs only and any repairs must be made at the shop or place designated in writing by Aiphone. Aiphone will not be responsible for any costs incurred involving on site service calls. Aiphone will not provide compensation for any loss or damage incurred by the breakdown or malfunction of its products during use, or for any consequent inconvenience or losses that may result.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy, and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures: • Reorient or relocate the receiving antenna • Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. Increase the separation between the equipment and receiver. • Consult the dealer or an experienced radio/TV technician for help.

The object area of (WEEE) is EU.